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 डिजजटर हस्ताऺय क्मा हैं ? 

 डिजजटर हस्ताऺय एक इरेक्रॉननक हस्ताऺय है, जजनका उऩमोग कय ककसी डिजजटर सॊदेश/दस्तािेज को बेजन ेिारे की 
ऩहचान की जाती है औय मह सुननजचचत ककमा जाता है कक सॊदेश अथिा दस्तािेज भें ककसी प्रकाय की छेड़छाड़ मा जारसाजी 
नहीॊ की गई है। डिजजटर हस्ताऺय मुक्त सॊदेश बेजने के फाद हस्ताऺयकताव सॊदेश की विषम साभग्री से न तो अनसबऻता 
जाटहय कय सकता है, औय ना ही इससे भुकय सकता है। इस प्रकाय डिजजटर हस्ताऺय सॊदेश बेजन ेिारे की सही ऩहचान 

सुननजचचत कयतें है औय सॊदेश प्राततकताव को मह विचिास टदरातें है कक प्रातत होने िारा सॊदेश सही पे्रषक द्िाया बेजा गमा है 

औय मह अऩने भरू स्िरूऩ भें है। 
 सूचना प्रौद्मोगगकी अगधननमभ-2000 की धाया 2(1)(p) भें डिजजटर हस्ताऺय को ऩरयबावषत कयते हुए कहा गमा है कक 

डिजजटर हस्ताऺय का आशम अजननमभ की धाया 3 भें विटहत प्रकिमा अथिा ककसी इरेक्रॉननक ऩद्धनत द्िाया ककसी 
इरेक्रॉननक असबरेख का ककसी सब्सिाईफय द्िाया प्रभाणीकयण ककमा जाना है। अगधननमभ की धाया 3 भें डिजजटर 

हस्ताऺय के ननभावण एिॊ सत्माऩन सॊफॊधी सम्ऩूणव प्रकिमा िर्णवत की गई है।  

डिजजटर हस्ताऺय क्मों ? 

 ितवभान भें सबी विबागों एिॊ कामावरमों भें भैन्मुअर असबरेखों के साथ-साथ रगबग प्रत्मेक कामव के इरेक्रॉननक असबरेख 

बी यखे जाते हैं। इरेक्रॉननक असबरेखों की कॉऩी कयना, सॊशोधन कयना, अगधक सॊखमा भें भेर मा अन्म भानमभों से 

वितरयत कयना, सॊग्रह कयना, िेटा ऩुनव प्राजतत (Data Retrieving) कयना सयरता ऩूिवक सॊबि होता है।  

  ऐसी जस्थनत भें िेटा/इरेक्रॉननक सॊव्मिहाय की प्रभार्णकता एिॊ विचिसनीमता अत्मॊत भहत्िऩूणव हो जाती है। अत् जजस 

प्रकाय स्माही हस्ताऺय से मह ससद्ध होता है कक मह ककसी ऩद विशेष ऩय ऩदस्थ ककसी अगधकृत अगधकायी द्िाया जायी 
प्रभार्णक दस्तािेज है, उसी प्रकाय इरेक्रॉननक दस्तािेजों की प्रभार्णकता डिजजटर हस्ताऺय के भानमभ से ही ससद्ध की जा 
सकती है। इस प्रकाय डिजजटर हस्ताऺय ई-गिनेन्स एिॊ ई-काभसव के ऺेत्र भें, इॊटयनेट को सुयक्षऺत भानमभ के रूऩ भें 
उऩमोग कयने के सरए अत्मॊत आिचमक है।  

डिजजटर हस्ताऺय की प्रभुख ववशेषताऐॊ 
 प्रभाणीकयण (Authentication) : अथावत डिजजटर हस्ताऺय के भानमभ से इरेक्रॉननक सॊदेश/दस्तािेज को पे्रवषत कयने 

िारे (Sender) अथिा स्त्रोत (Source) की ऩहचान को प्रभार्णत कयता है। 

 शुद्धता (Integrity) : अथावत मटद ककसी सॊदेश को डिजजटर हस्ताऺरयत ककमा गमा है तो हस्ताऺय के ऩचचात उसभें ककसी 
बी प्रकाय का ऩरयितवन/सॊशोधन सॊबि नहीॊ है। सॊशोधन की जस्थनत भें उक्त सॊदेश एक निीन सॊदेश होगा जजसे ऩुन् 
डिजजटर हस्ताऺरयत कयना होगा। 

 स्ऩष्ट उत्तयदायमत्व (Non-Repudiation) : अथावत अऩने डिजजटर हस्ताऺय कय ककसी सॊदेश/दस्तािेज को पे्रवषत कयने 

िारे (Sender) व्मजक्त/अगधकायी इस फात से इॊकाय नहीॊ कय सकते कक उक्त सॊदेश/दस्तािेज उनके द्िाया नहीॊ बेजा गमा 
है। 

डिजजटर हस्ताऺय के प्रभुख उऩमोग 
 प्रकयणों का ऑनराईन अनममन कय स्िीकृनत प्रदान कयना।  
 कम्ऩमूटयीकृत दस्तािेजों का ऑनराईन सत्माऩन कयना। 
 प्रभार्णक/अगधकृत रूऩ से ऑनराईन आिेदन कयना। 
 रामसेंस, ऩयसभट, प्रभाणऩत्र, स्िीकृनत, इत्माटद ऑनराईन जायी कयना। 

 

डिजजटर हस्ताऺय की वैधायनक  

 

 बायत भें सूचना प्रोद्मोगगकी अगधननमभ 2000 एिॊ 2008 के तहत डिजजटर हस्ताऺय को िैधाननक भान्मता प्रदान की गई है। 
डिजजटर हस्ताऺय िैधाननक रूऩ से मह घोषणा कयतें है कक इनका प्रमोग कय सॊदेश बेजने िारे व्मजक्त की ऩहचान क्मा है, सॊदेश 

अऩने प्राततकताव के ऩास ऩहुचने तक अऩरयिनतवत यहा औय सॊदेश बेजने िारा व्मजक्त इस सॊदेश भें उल्रेर्खत फातों से भुकय नहीॊ 
सकता है।  
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डिजजटर हस्ताऺय कैसे काभ कयता है ? 

 डिजजटर हस्ताऺय ऩद्धनत भें 2 कुॊ जजमों मथा ''ननजी कुॊ जी (Private Key) एिॊ सािवजननक कुॊ जी (Public Key) का इस्तभेार ककमा 
जाता है। ''ननजी कुॊ जी (Private Key) गोऩनीम ऩासििव की तयह होती है, जजसकी जानकायी केिर डिजजटर हस्ताऺयकताव के ऩास 

होती है, जफकक 'सािवजननक कुॊ जी (Public Key) सािवजननक होती है, जजसे कॊ रोसरॊग अथोरयटी की िेफाईट ऩय देखा जा सकता है। जजस 

दस्तािेज/सॊदेश ऩय डिजजटर हस्ताऺय कयना है, सिवप्रथभ उसकी ''हेश िेल्मू'' (Hash Value) ननसभवत की जाती है। ''हेश िेल्मू'' ककसी 
बी दस्तािेज की अद्वितीम ऩहचान है, जजसे ''ननजी कुॊ जी (Private Key) का उऩमोग कय एनकितट ककमा जाता है।  

                                    ''ननजी कुॊ जी (Private Key) से एनकितट होने िारे दस्तािेज को केिर उसकी जोड़ीदाय 'सािवजननक कुॊ जी 
(Public Key) से ही डिकितट ककमा जा सकता है। दस्तािेज प्राततकताव अऩने कम्तमूटय ऩय दस्तािेज की ''हेश िेल्मू'' दोफाया ननसभवत 

कयता है औय दस्तािेज के साथ आने िारी एनकितटेि ''हेश िेल्मू'' को पे्रषक की 'सािवजननक कुॊ जी (Public Key) से डिकितट कयता है। 
मटद दोनो ''हेश िेल्मू'' सभान होती है तो मह सुननजचचत हो जाता है कक दस्तािेज सही व्मजक्त द्िाया बेजा गमा है इसभें ककसी प्रकाय की 
जारसाजी नहीॊ हुई है। 
 

डिजजटर हस्ताऺय कैसे काभ कयता है ? 

 

 डिजजटर हस्ताऺय ऩद्धनत भें 2 कुॊ जजमों मथा ''ननजी कुॊ जी (Private Key) एिॊ सािवजननक कुॊ जी (Public Key) का इस्तेभार 
ककमा जाता है। ''ननजी कुॊ जी (Private Key) गोऩनीम ऩासििव की तयह होती है, जजसकी जानकायी केिर डिजजटर 
हस्ताऺयकताव के ऩास होती है, जफकक 'सािवजननक कुॊ जी (Public Key) सािवजननक होती है, जजसे कॊ रोसरॊग अथोरयटी की 
िेफाईट ऩय देखा जा सकता है। जजस दस्तािेज/सॊदेश ऩय डिजजटर हस्ताऺय कयना है, सिवप्रथभ उसकी ''हेश िेल्मू'' (Hash 

Value) ननसभवत की जाती है। ''हेश िेल्मू'' ककसी बी दस्तािेज की अद्वितीम ऩहचान है, जजसे ''ननजी कुॊ जी (Private Key) 
का उऩमोग कय एनकितट ककमा जाता है।  

                                    ''ननजी कुॊ जी (Private Key) से एनकितट होने िारे दस्तािेज को केिर उसकी जोड़ीदाय 'सािवजननक 
कुॊ जी (Public Key) से ही डिकितट ककमा जा सकता है। दस्तािेज प्राततकताव अऩने कम्तमूटय ऩय दस्तािेज की ''हेश िेल्मू'' 

दोफाया ननसभवत कयता है औय दस्तािेज के साथ आने िारी एनकितटेि ''हेश िेल्मू'' को पे्रषक की 'सािवजननक कुॊ जी (Public 

Key) से डिकितट कयता है। मटद दोनो ''हेश िेल्मू'' सभान होती है तो मह सुननजचचत हो जाता है कक दस्तािेज सही व्मजक्त 
द्िाया बेजा गमा है इसभें ककसी प्रकाय की जारसाजी नहीॊ हुई है। 
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डिजजटर हस्ताऺय के प्रकाय  

 िभाॊक  प्रकाय  उऩमोग  अवधध
 1 Class '0' 

(Zero) 

 Certificate

 मह सटटवकपकेट केिर प्रदशवन/ऩयीऺण हेतु जायी ककमा जाता है।       ---

 2 Class '1' 

(One) 

 Certificate

मह सटटवकपकेट ननजी उऩमोग के सरमे जायी ककमा जाता है। मह साभान्म 
स्तय के डिजजटर हस्ताऺय होतें है जो भात्र उऩमोगकताव औय उसके इभेर 
अकाउन्ट को सत्मावऩत कयतें है। जहॉ उच्च स्तयीम विचिसनीमता एिॊ 

िचनफद्धता की आिचमकता नहीॊ होती है िहा इस स्तय के सटटवकपकेट उऩमोग 
 भें रामे जातें है। 

1 मा 2 
 िषव।

 3 Class '2' 

(Two) 

 Certificate

मह सटटवकपकेट ननजी उऩमोग एिॊ व्मिसानमक उऩमोग, दोनो के सरमे जायी 
ककमा जाता है। मह भनमभ स्तय के डिजजटर हस्ताऺय होतें है, जजनका 
उऩमोग छोटे वित्तीम रेनदेन से सॊफॊगधत दस्तािेजों मा आिेदनों की 

 विचिसनीमता ससद्ध कयने के सरमे उऩमोग ककमे जातें है। 

1 मा 2 
 िषव।

 4 Class '3' 

(Three) 

 Certificate

मह सटटवकपकेट व्मजक्तमों एिॊ सॊस्थाओॊ दोनों को जायी ककमा जाता है। मह 
एक अत्मॊत उच्च स्तयीम िचनफद्धता के प्रभाण ऩत्र हैं जो कक भुखमत् ई-

कॉभसव गनतविगधमों हेतु जायी ककमे जात ेहैं। व्मजक्तमों के सरए जायी कयने से 
ऩूिव सटटवपाईंग अथॉरयटी के साभने उन व्मजक्तमों की व्मजक्तगत उऩजस्थनत 

 अननिामव होती है

1 मा 2 
 िषव।

 
 

डिजजटर हस्ताऺय की वैधता की सभाजतत अथवा खो जाना  

 
डिजजटर हस्ताऺय प्रभाण ऩत्र अगधकतभ 2 िषव तक की अिगध के सरमे िैध होतें है। ककन्ही विशेष ऩरयजस्थनतमों, जैसे नाभ भें ऩरयितवन, 
डिजजटर हस्ताऺय उऩमोगकताव का सेिा से ऩथृक होना, ''प्रामिेट की'' की गोऩनीमता बॊग होने की आशॊका होना, आटद भें अिसान नतथी 
के ऩूिव बी इनकी िैधता सटटवपानमॊग अथोरयटी द्िाया सभातत की जा सकती है।  
डिजजटर ससग्नेचय खो जाने की जस्थनत भें आऩ इसे फॊद कयिा सकत ेहै आऩको इस सम्फन्ध भें अऩनी यजजस्टिव इभेर आई 
िी से िन विबाग के आई टी विबाग के अनुभोदन सटहत आऩने यजजस्रेशन आथारयटी को इभेर सरखना होगा इभेर सरखे | 
 

डिजजटर हस्ताऺय कैसे प्रातत ककमा जामे ? 

 
बायत सयकाय द्िायाव CCA कॊ रोरय आप सनतवफाइन्ग आथारयटी ने कुछ Certifying आथारयटी को डिजजटर ससग्नेचय जायी 
कयने की भान्मता दी है मे Certifying आथारयटी अऩने यजजस्रेशन आथारयटी के भानमभ से ससग्नेचय जायी कयती है | 
 
Safescrypt TCS nCode eMudhra Caprocorn Identity IDBRT इत्माटद सनतवपैं ग एजेंसी है तथा मे अऩने यजजस्रेशन 
अथारयटी के द्िाया ससग्नेचय उऩरॊब कयिात ेहै आऩकी यजजस्रेशन अथारयटी फाराजी कम्तमुसाफ्ट ( फाराजी साल्मूशन ) है 
आऩ इस सम्फन्ध भें dsc@digitalsignature.net.in ऩय इभेर कय सकत ेहै | 
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डिजजटर प्रभाण ऩत्र की साभग्री: 
 
• सीरयमर नॊफय: अनोखे प्रभाण ऩत्र की ऩहचान कयने के सरए इस्तभेार ककमा। 

 

• विषम: व्मजक्त मा सॊस्था की ऩहचान की। 
 

• हस्ताऺय एल्गोरयथ्भ: हस्ताऺय फनाने के सरए इस्तभेार एल्गोरयथ्भ। 
 

• हस्ताऺय: सत्मावऩत कयने के सरए िास्तविक हस्ताऺय है कक मह जायीकताव से आमा है। 

 

• जायीकताव: इकाई है कक सूचना औय सत्मावऩत प्रभाण ऩत्र जायी ककए हैं। 
 

• िैध-से: नतगथ प्रभाण ऩत्र ऩहरे से िैध है। 
 

• भान्म कयने के सरए: सभाजतत की तायीख। 
 

• कुॊ जी-उऩमोग: सािवजननक कुॊ जी (उदाहयण के सरए कूटरेखन, हस्ताऺय, प्रभाणऩत्र हस्ताऺय) के प्रमोजन। 
 

• सािवजननक कुॊ जी: सािवजननक कुॊ जी एजन्ितशन एजन्ितशन औय इसके साथ जुड़ ेिटेा के डिकितशन के सरए एक 
भहत्िऩूणव जोड़ी का उऩमोग कयता है। 
 

• Thumbprint एल्गोरयथ्भ: सािवजननक कुॊ जी हैश कयने के सरए इस्तभेार ककमा एल्गोरयथ्भ। 
 

• Thumbprint: हैश ही, सािवजननक कुॊ जी का एक सॊक्षऺतत रूऩ के रूऩ भें इस्तभेार ककमा।
 
 

 डिजजटर ससग्नेचय की वैधायनक भान्मता  

 
 

The Indian Information  Technology Act 2000 (http://www.mit.gov.in/content/information-technology-act)   came 
into effect from October 17, 2000. One of the primary objectives of the Information Technology Act of 2000 was 
to promote the use of Digital Signatures for authentication in e-commerce & e-Governance. Towards facilitating 
this, the office of Controller of Certifying Authorities (CCA) was set up in 2000. The CCA licenses Certifying 
Authorities  (CAs)  to  issue Digital  Signature  Certificates  (DSC)  under  the IT  Act  2000.  The  sta ndards  and 
practices to be followed were defined in the Rules and Regulations under the Act and the Guidelines that are 
issued by CCA from time to time. The Root Certifying Authority of India (RCAI) was set up by the CCA to serve 
as the root of trust in the hierarchical Public Key Infrastructure (PKI) model that has been set up in the country. 
The RCAI with its self-signed Root Certificate issues Public Key Certificates to the licensed CAs and these 
licensed CAs in turn issue DSCs to end users. 
 

Section 5 of the Act gives legal recognition to digital signatures based on asymmetric cryptosystems. The digital 
signatures are now accepted at par with the handwritten signatures and the electronic documents that have 
been digitally signed are treated at par with the paper based documents. 

An  Amendment  to  IT  Act  in  2008  has  introduced  the  term  electronic  signatures.  The  implication  of  this 
Amendment is that it has helped to broaden the scope of the IT Act to include other techniques for signing 
electronic records as and when technology becomes available. 
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PUBLIC KEY INFRASTRUCTURE IN INDIA 

 

PKI is the acronym for Public Key Infrastructure. The technology is called Public Key cryptography because unlike 
earlier forms of cryptography it works with a pair of keys one of which is made public and the other is kept secret. One 
of the two keys may be used to encrypt information which can only be decrypted with the other key. The secret key is 
usually called the private key. Since anyone may obtain the public key, users may initiate secure communications  
without having to previously  share a secret through some other medium with their correspondent. PKI is thus the 
underlying system needed to issue keys and certificates and to publish the public information. PKI is a combination of 
software, encryption technologies, and services that enable enterprises to protect the security of their communications 
and business transactions over networks by attaching so-called “digital signatures” to them. 

 

The  Office  of  the  Controller  of  Certifying  Authorities  (CCA),  has  been  established  under  the  Information 
Technology (IT) Act 2000 for promoting trust in the electronic environment of India. The current PKI organization 
structure in India consists of the Controller of Certifying Authority as the apex body and as the Root Certifying Authority 
of India (RCAI)( as shown in the figure on PKI Heirarchy). The CCA is entrusted with the following responsibilities : - 

 

 Licensing Certifying Authorities (CAs) under section 21 of the IT Act and exercising supervision over their 
activities. 

 Controller of Certifying Authorities as the “Root” Authority certifies the technologies and practices of all  the 
Certifying Authorities licensed to issue Digital Signature Certificates 

 Certifying the public keys of the CAs, as Public Key Certificates (PKCs). 
 

 Laying down the standards to be maintained by the CAs. 

 Conflict resolution between the CAs 

 Addressing the issues related to the licensing process including: 

a)   Approving the Certification Practice Statement (CPS); 

b)  Auditing the physical and technical infrastructure of the applicants through a panel of auditors maintained by the 
CCA. 

 
The  RCAI  is  responsible  for  issuing  Public  Key  Certificates  to  Licensed  Certifying  Authorities  (henceforth 
referred  to as  Certifying  Authorities  or CA).  The  CAs  in turn  are responsible  for  issuing  Digital  Signature 
Certificates to the end users. In order to facilitate greater flexibility to Certifying Authorities, the CCA has allowed the 
creation of sub-CAs. As per this model, a Certifying Authority can create a sub-CA to meet its business branding 
requirement. However the sub-CA will be part of the same legal entity as the CA. 

The sub-CA model will be based on the following principles: 

    The CAs must not have more than one level of sub-CA 
    A sub-CA certificate issued by the CA is used for issuing end entity certificates 

    A CA with sub-CA must necessarily issue end entity certificates only through its sub-CA. The only exception will be 
for code signing and time stamping certificates, which may directly be issued by the CA. 
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2.डिजजटर ससग्नेचय को टोकन भें स्टोय कयना    

डिजजटर ससग्नेचय स्टोय कयने हेतु भानमभ  

 

 1 स्भाटव कािव इसभें स्भाटव कािव यीिय की आिचमकता होती है  
 2 USB eTOKEN इसे ऩेन ड्राइि के जैसे उऩमोग कय सकत ेहै  | 

 
  

We Provide ePass 2003 eToken and a name Label Chain to Identity it 
 
 

                                  
 
 
 

 Auto Plug & Play- No CD required for Driver Installation. 

 Supported OS: 32bit and 64bit Windows XP SP3, Server 2003 , Vista, Server 2008, Seven, Eight,     

 32bit and 64bit Linux and MAC OS X 

 FIPS 140-2 Level 3 Certified and Cap for each USB Token is Included. 

 Memory Space: 64KB (EEPROM) - Can store around 7-10 DSC. and Connectivity: USB 2.0 full  

 speed, Connector type A 

 Laser Printed Serial Number on each token.  
 

Make NOTES ---- 
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 टोकन ड्राइवय इॊस्टारेशन ससस्टभ चेककॊ ग जावा सेटटॊग ब्राउसय िेटटॊग  

 

 अननिामव प्रणारी की जाॉच 

 जो विॊिोज अऩने ससस्टभ भें स्थावऩत ककमा गमा है की जाॉच कैसे कयें  
 अऩने इॊटयनेट एक्सतरोयय सॊस्कयण की जाॉच कैसे 

 कैसे जाॊच कये के सरए मूएसफी टोकन ड्राइिय सही काभ कय यहा है 

 जािा सेटटॊग्स! 
 इॊटयनेट एक्सतरोयय सेटटॊग्स 

 टोकन वऩन औय अनब्रॉक ऩासििव फदरना  

इटोकन भें ड्राइिय टोकन भें बी है अथिा आऩ हभायी िेफसाईट www.digitalsignature.net.in/forestit/ भें जा के ड्राइिय िाउनरोि 
कय सकत ेहै |  

 

याईट जक्रक इटोकन इन भाई कॊ तमूटय  ओऩन सेट अऩ  इॊस्टार  जक्रक आई अग्री  इॊस्टार  नेक्स्ट इॊस्टार  

 

इॊस्टार कयत ेसभम इॊजग्रश रेंगुअज चुने तथा भाइिोसाफ्ट CSP चुननए  

 

 

 

 

 

 

शोटभ कट ऑफ़ टोकन भेनेजय िसे्कटाऩ भें 
इॊस्टार हो जाएगा 
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Click the ICON to OPEN  Token Manager          

इ टोकन  भें अऩने ससग्नेचय को कैसे देखे अथवा ऩासविभ कैसे फदरे  - ऩासििव फदरने के सरए चेंज मूजय वऩन ऩय 
जक्रक कये तथा ऩुयाना वऩन जो की डिपाल्ट भें १२३४५६७८ यहता है की जगह नमा फना रे  

 

You can also view the details of the certificate by opening the Feitian PKI Manager as shown in the figure below:अऩने सटटवकपकेट की 
जानकायी बी आऩ टोकन को जक्रक कय के डिटेल्स भें जा के देख सकत ेहै |  

 
Fig. 1.25: Certificate details from the Feitian PKI Manager ePass 2003 

 

vius Vksdu dks  iklokMZ vki pkgsrks cny ldrs gS nl ckj xyr iklokMZ Mkyus ij vkidk dk iklokMZ CykWd gks 

tkrk gSA Vksdu xqe tkus ij vFkok iklokMZ CykWd gksus ij uhps fn;s gqbZ bZ&esy ij laidZ djsaA 

 



 
 

: Introduction to Digital Signature 

  

BALAJEE COMPUSOFT P LTD BHOPAL --------TOLL FREE  180030002448  Page 10 

 

 

 DROP A EMAIL dsc@digitalsignature.net.in to raise Ticket with the Approval from APCCFIT to Block and revoke the etoken 

     
How to check whether  USB Token driver is successfully installed and working in your system? ;g vko’; tkap dj ys 

dh vki dk ;w-,l-ch Vksdu lgh dke dj jgk gSA 

a.   Insert USB Token in any USB port. 
 

b.   Wait for a while till computer recognizes and reads your USB Token. c.   

Now open Internet Explorer Browser. 

d.   Go to Tools> Internet Options (or just press Alt + T + O) 
 

e.   Navigate to Content Tab > Certificates. 
 

f.    If you can see your Digital Signature Certificate name here, then your USB Token is working fine. 
 

Otherwise install your USB Token driver first and then proceed with this point again. 

 

 

 

 

fMftVy aflxuspj ds mi;ksx ds nkSjku vkus okyh fofHkUUk rduhd leL;k dk dkj.k lgh 

vkWijsfVax flLVe u gksuk tkok viMsV u gksuk lgh Mªkboj ugh Mkyk gksuk vFkok oso czkmtj dh 

lsfVad lgh ls u gksuk  gS A जजस कायण सही इॊस्टार होने के फाद बी टोकन नहीॊ चरता है इससरए 
ननम्न जाॊच कय रे  

 आऩ का ससस्टभ अगय ऩुयाना है एक्स ऩी तो उसे सविवस ऩैक 3 से  अऩिटे कये | टोकन 
विॊिो सेिन सविवस ऩैक िन भें सही  काभ कयते है  

 जािा इॊस्टार नहीॊ है तो उसे इॊस्टार कये  
 जािा की सेटटॊग्स कये कॊ रोर ऩैनर  ओऩन जािा  ससक्मुरयटी सभननभभ यखे  
 कई फाय टोकन ब्राक यहता है तो स्भाटव कािव इनेफर कये  
 यन सविवसेज.msc स्भाटव कािव इनेफर  रयस्टाटव ससस्टभ  

अगय ब्राउसय भें टोकन मुस कयना है तो ब्राउसय की सेटटॊग्स कयनी होगी तथा जािा भें िेफसाईट को 
जोड़ना होगा | हभायी िफेसाईट भें साया विस्ततृ सगचत्र स्टेऩ सटहत साड़ी सेटटॊग्स तथा अन्म तकनीक 
स्जान्कायी आऩ िाउनरोि कय सकते है  

www.digitalsignature.net.in/forestit 
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 If there  is more  than  one JAVA  installed,  remove  all JAVA versions  from your system by uninstalling all of 

them.After uninstalling all java, download and install latest java version of 32 bit only. It doesnotmatterif your system 

is 64 bit. At present latest JAVA is JRE 7 update 51. Then restart your system.After restart, open Java in control 

panel. Double Click on Java (32-bit) icon. A dialog box will appear 

 

 lE;qjsVh okys Vsc esa lwj{kk dk rhj lcls uhps djsa  

 ftl osclkbVdks vki ;qt djs jgks gks mldks ,Dlslsik’ku lkbZV esa tksM+ ns baVjusVu 

,Dlizksyj dh lsfaVd dSls djsaA 

 flE;qjsVh Vsc ds dkLVe yscy esa tkdj lkjs ,D;w,Dl buscy djsa tks uksV flD;wjks gS mUgsa 

izkEV djsaA 

 VªLVsM lkbZV esa ftl osclkbZV esa fMftVy flaxuspj mi;ksx djuk gks fQj tksM+s uhsps fn;s 

fp= ds vuqlkj vki lasfVax dj ldrs gSA  
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भेक नोट्स  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now  have to restart you system  and your most of 

the   non any token resolved  
 

us with screenshots of your problem if it  persists or  

us with  of  
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-Governance is at the center of Digital Transformation for Governments and digital signatures can 

enable Digital Transformation by making Government to Citizen services and vice versa completely 

paperless. 

 
The following are the lessons learnt and the road ahead suggested for implementation of digital 

signatures in the e-Governance programmes:- 

 
The digital signature implementation must be end to end available without any 

dependecy on proprietary OS. 

The verifications must happen on the local application servers, else the implementation model 

may fail in the remote applications in the rural landscape. 

The State Government needs to develop its own franchisee model for management of 

digital signatures on a day to day basis, else it may impede decision making. 

No physical signature should be promoted on print outs of any digitally signed certificates/ 
documents 

Awareness campaign should be launched in national and local media (in local languages) 
regarding what is digital signature and how it benefits the citizens. 

 
 

 
 

  
Figure: Screenshot of a Digitally Signed Residence 

Certificate 
 
 

E 
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3.डिजजटर हस्ताऺय के सपर कामाभन्वमन  

 
S.No Project Use of Digital Signatures 

1.  
 
eDistrict  – ई जजरा  

 

Digital Signatures are being used for 

electronically signing the Certificates being 

issued through eDistrict Centres / CSCs 

etc The approving authority puts his Digital 

Signatures at the time of approving the 

certificate and the related information is 
printed on the certificate also. 
This not only ensures that the details of the 

signing authority is displayed, even the 

DSC of the signatory can be verified over 

the Internet. 

2  
 

Online         Counselling          
ऑनराइन काउॊ ससरॊग 

 
admission to seats of 

Engineering, Medical, 

Polytechnic & B.Ed. courses. 

The  Digital  Signatures  are  being  used  

by the Counselling In-charge for document 

verification,  fee  submission,  registration  

& for choice locking opted by the 

candidates which are finally locked by the 
invigilators using DSC. Class II DSC are 

being used for these activities 
 

In case of any modification  in the 

student record, the same can be carried 

out only through digital signatures in order 
to ensure the same is recorded in the 

database. 
3 eProcurement  

 आनराइन टेंिरयॊग  is    an    
online tender processing 
system for the stateक/central 
government departments. More  
than  1000  tenders published 
so far. 

The Digital Signatures are being used 

both by the vendors and government 

officials for tender submission and 

processing. The vendors/traders are using 

it for applying tenders  online,  while  the  
government officials are using it at time of 

opening the tenders and during finalizing 

of the tenders. 
 

Class II signatures are being used both for 
signing and encryption of data. 4 Voters  List Adhar Preparation   

field data along with the photo 
ID will be digitized and the same 

will be digitally signed assuring 

the correctness of data. 

The DSC will be used to counter verify the 

digitised data of voters list and the photo 

ID. This can be used by other applications 

such as eDistrict for online verification of 
citizen details. 
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4. DIGITAL SIGNING OF IMAGES GIF/JPEG FMFTVY FLSAXUSPJ DS }KJK BEST BR;KFN GLRKK{KFJR DJUK  

 

This is registered to MP Forest and can be obtained from Forest Website by Contacting IT Department APCCFIT 

भध्म प्रदेश वन ववबाग हेतु प्रदत्त साफ्टवेमय द्वाया स्कैन इभेज नक़्शे िाक्मूभेंट आऩ सत्मावऩत कय सकत ेहै  

STEP INSTALL P7S SIGNER SOFTWARE –Click ICON to install p7s Signing SW and select I agree to install it  

      P7S SIGNER SOFTWARE  ihlsou lkW¶Vos;j dks vksiu djs vkSj LVkWy djsa 

 

 

 
 

 

Once you have installed the SW it will be saved in DESKTOP 

STEP 2 – OPEN DESKTOP SHORTCUT TO OPEN SW 
      MsLVVki ij cus gq, lkWVdVZ ls vki lkW¶Vos;j [kksys 

 

 

 

 

 

STEP 3 . vki bl lkW¶Vos;j ds }kjk ,d ckj esa ,d best vFkok  Ldsu best ls Hkjk gqvk QksYMj fMftVy 

lR;kfir dj ldrs gSS vki dks lcls igys lknh best dk  LFkku rFkk fMftVy lkbZu best dk LFkku pqukuk 

gksaxkvki dks viuk bZ&Vksdu yxk dj fMftVy Vksdu pqukuk gksxkA 
1 SELECT SINGLE OR FOLDER OF IMAGE आऩ को इभेज का सोसव चनुना होगा  

2  SELECT DESTINATION OF IMAGE SIGNED आऩ डिजजटर साइन कयने के फाद उसे कहा यखना चाहत ेहै चनेु  

3 SELECT THE DIGITAL SIGNING OFFICER TO APPLY अगधकायी का डिजजटर साइन चनुनए  

Image Signer Software is 

Registered Software for MP 

Forest Department  

Images of JPEG and GIF 

Format will be saved in p7s 

format with Authentication 

provided from Digital 

Signature of Signing Officer  
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ONCE YOU HAVE SELECTED SIGNATURE YOU CAN SEE THE DETAILS AS IN POINT NO 4 जैसे ही आऩ डिजजटर साइन चुनत ेहै 
अगधकायी के डिटेर भें जानकायी 4 नॊफय अनुसाय टदखेगी  
5. APPLY THE SIGNATURE AS IN POINT 5  आऩ हस्ताऺय रगाइए  

 

AFTER FEW SECOND THE FILE WILL BE SIGNED AND WILL BE SAVED IN DESIRED LOCATION AS HERE BELOW 

 

vki fMftVy aflxuspj tSls gh ,QkykbZ djrs gS FkksMs le; ckn vki dh best fMftVylkbZu gks tk;sxh 

 

      

vki fMftVylkbZu dks best dks bZesy dj ldrs gS rFkk vki ml best dks vksiu dj ds fMftVylkbZu gLrk{kj 

djus okys dk uke ns[k ldrs gS rFkk pkgs rks fcuk fMftVylkbZu ds ikseZV esa lso dj ldrs gS 

 

YOU CAN CLICK SIGNATURE DETAILS BY DOUBLE CLICK THE FILE AND THEN SAVE THE UNSIGNED FILE AS YOU MAY NEED  
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  

PUBLIC KEY CRYPTOGRAPHY STANDARDS PKCS  

IMAGE SIGNING FORMAT  IS P7S P7M WHICH YOU MAY SELECT CUSTOM CONFIGURATION IN SOME CASES, YOU WILL NEED A 
DIFFERENT SIGNATURE CONFIGURATION (E.G. DIFFERENT SIGNATURE APPEARANCE AND DIGITAL CERTIFICATES) FOR DIFFERENT FILES/FOLDERS.  

 
To save a specific configuration, go to File – Save Configuration As and save the configuration on a file. Later, you can use that file in 

batch mode to apply different signature configuration on your signed file. आऩ फाइर  सेि कॊ कपगुय भें अऩनी सेटटॊग्स इत्माटद सेट कय के 
यख सकत ेहै  

 

 

नोट्स फनाने के सरए स्ऩेस   
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4 DIGITAL SIGNING OF PDF DOCUMENTS –PDF SIGNER SOFTWARE 

ऩी िी ऍफ़ साइनय साफ्टवेमय 

 

ऩी िी ऍफ़ साइनय साफ्टवेमय जो की भध्मप्रदेश पायेस्ट ववबाग के नाभ से यजजस्टिभ है से आऩ अऩनी इभेज अथवा िाक्मूभेंट 
जो की ऩी िी ऍफ़ पाभेट भें है उन ऩय डिजजटर ससग्नेचय रगा सकते है  ऩी िी ऍफ़ पाभेट होने के कायण आऩना ससग्नेचय 
नजय आता है तथा आनराइन वेयीपाई बी हो सकता है  

–This is registered to MP Forest and can be obtained from Forest Website by Contacting IT Department APCCFIT 

 Portable Document Format (PDF)Is best and suitable format to Sign Files Digitally as the Signature Details is Visible in the 
Documents and it can be validated also . 

 

इभेज को ऩी िी ऍफ़ भें फदरने के तयीके 

 

STORED IMAGES MAPS DOCUMENTS LETTER CAN BE CONVERTED INTO PDF EASILY ऩी िी ऍफ़ भें कैसे फदरे  

 Use GOOGLE CHROME ----Open Google Chrome DRAG n DROP Image into chrome  Click CTRL + P ( File Print) . आऩ गूगर 
िोभ भें सीधे इभेज को ड्रगे कय के उसे ऩी िी ऍफ़ भें सेव कय सकत ेहै | 

 In Print Option Choose Save AS  PDF and the file is stored as PDF फाइर वप्र ॊट सेि  

 USE FREE PDF CONVERT SOFTWARE  LIKE do pdf ,icecreampdf ,pdf maker etc गूगर भें सचव कय िाउनरोि कये  

 Use Free Online PDF Converting Website Like https://www.freepdfconvert.com/  https://online2pdf.com https://www.wordtopdf.com  

convertonlinefree.com  etc etc आनराइन बी आऩ फ्री कन्िटव कय सकत ेहै | 

 RECEIVE CONVERTED FILE IN YOUR EMAIL - Alternatively, you can forward the original email message 

to pdfconvert@pdfconvert.me and the service will send a PDF version of the message back to you in a second or two. आऩ सीधे 
इभेर कय सकत ेहै औय तुयॊत आऩको ऩी िी ऍफ़ फ़ाइर प्रातत होगी  

 If there are any Word, Excel or Powerpoint attachments inside the mail, you can forward the files 

to attachconvert@pdfconvert.me and they’ll come back to you in PDF format. आऩ Word, Excel or Powerpoint attachments 

सीधे इभेर कय सकत ेहै औय तुयॊत आऩको ऩी िी ऍफ़ फ़ाइर प्रातत होगी 
-------------------------------नोट्स फनाने हेतु स्थान   
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वन ववबाग का ऩी िी ऍफ़ साइनय साफ्टवेमय 

 

 वन ववबाग का ऩी िी ऍफ़ सेनय साफ्टवेमय इॊस्टार करयए िसे्कटाऩ शाटभ कट से खोसरए  

 

 

 
 

ONCE YOU 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Install the Software PDF Signer  Agree  Install  Shortcut is created @DT साफ्टवेमय 
इॊस्टार कये िसे्कटाऩ ऩय शाटभकट फन जाएगा उसे खोरे  
Select PDF Single Document or Folder Origin and Destination Both आऩ ऩी िी ऍफ़ फ़ाइर 
अथवा उनका पोल्िय चुने तथा उसे कहा यखना है वो स्थान बी तम कये  
Select Reason and Place of Signing if needed आऩ ककस कायण से िाक्मूभेंट साइन कय सहे है 
मटद हो तो सरखे तथा साइन कयने का स्थान बी दे  

1 Select Digital Signature to sign the Documents आऩ अधधकायी का हस्ताऺय चुने  

2 आऩ अधधकायी के  ससग्नेचय को रगा दे  

3 You Can configure signature appearance by  Checking into Visible Sign Box and 

include adobe Right Tick and Question mark Status for validation also आऩ अऩने 
हस्ताऺय भें अन्म जानकायी कैसे दे सकत ेहै इस सम्फन्ध भें जानकायी इस प्रकाय से है  
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DIGITAL SIGNATURE OPTIONS ससग्नेचय APPEARANCE ऩय जक्रक कयने से ओऩन होगा  

DIGITAL SIGNATURE RECTANGLE 

If the checkbox Visible signature box is checked, a signature rectangle will be inserted on the PDF document. The appearance of the digital 

signature can be customized from the Signature Appearance section. आऩ Visible signature box ऩय टटक कय दे तो आऩ के ससग्नेचय के आस 
ऩाय एक आमत फन जाएगा  

 

 
 

1 पाॊट साइज तथा िाइयेक्शन आप टेक्स्ट आऩ चुन सकत ेहै The default text direction is left to right. To change the text direction to right to left 

(e.g. for Hebrew language) checkbox Right to Left text must be checked.The default font file for the digital signature rectangle is Helvetica. It 
is possible that this font to not include all necessary UNICODE characters like ä, à, â. On this case you will need to use an external font. 
The font size is calculated based on the signature rectangle size in order to fit on the signature rectangle (it not have a fixed size). If you want 
to use a specific font size, it can be secified on the Font size section. 
 

Observation: If the custom position will be used, the corner (0,0) is on the bottom इन्क्रड़ु एिोफी ससग्नेचय भाकव  left of the page. फाई डिपाल्ट 
उरटे पाट तयप ननचे की ससग्नेचय आता है आऩ चाहे तो नमा  स्थान चनुचुन सकत ेहै | 
 

5 आऩ अऩने ससग्नेचय भें िेसरि का गचन्ह सही का हया ननशान  प्रचन गचन्ह इत्माटद इन्क्रुड़ एिोफी ससग्नेचय भाकव  से रे सकत ेहै  
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3 The default digital signature text contains information extracted from the signing certificate, signing date, signing reason and signing 

location but t digital signature text can be easily customized. ससग्नेचय भें आऩका नाभ टदनाॊक कायण औय स्थान 4 4 आता है आऩ चाहे तो 

LABELS तथा  CUSTOM TEXT को टटक कयके अन्म जानकायी दे सकत ेहै  

Set the Digital Signature Graphic ससग्नेचय के साथ  भें इभेज ससग्नेचय बी रगाना आऩ अऩनी ससग्नेचय की इभेज ब्राउस कय के रगा सकत ेहै  

The digital signature rectangle can contains text, graphic or text with graphic. To add an image on the digital signature rectangle, you can do 
that from Place an image on the signature box section. 

 

These types of signatures are shown below: इस तयह से इभेज नजय आएगी  

 

 

1. Image and text,       2. Image as background,          3. Image with no text

 

Signature text  
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USING SHA256, SHA512 HASH ALGORITHMS 

The default hash algorithm used by the library is SHA1 but in some cases, SHA256/384/512 must be used for the digital signature and the 
Time Stamp Request. 
 
Attention: SHA-256 and SHA-512 hash algorithms are not supported by Windows XP. Note that some smart cards and USB tokens not 
support SHA-256 and SHA-512 hash algorithms. 

  

Signed by, Reason, Location and Date properties in Adobe

 

Set the hash algorithm
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BYPASSING THE SMART CARD PIN स्राटभ कािभ का वऩन फाई ऩास कयने की ववधध आऩ I टोकन का ऩासविभ साफ्त्वदभ भें िार देत ेहै तो अफाय 
फाय आऩको ऩासविभ नहीॊ िारना होता है  

 
In case the digital signature must be made without user intervention and the certificate is stored on a smart card or USB token, the PIN 
dialog might be automatically bypassed for some models. 
 

 
 
In order to bypass the PIN dialog window, the Smart Card PIN checkbox must be checked and the right PIN to be 
entered.DigitalCertificate.SmartCardPin propery must be set. This option bypass the PIN dialog and the file is automatically signed without 
any user intervention. 
 

 
 
 
Attention: This feature will NOT work for all available smart card/USB tokens because of the drivers or other security measures. Use this 
property carefully. 
 

                      

 

 

 

 

 

 

 

 

PIN dialog can be bypassed

 

Bypassing the Smart Card PIN
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6.  ATTACHING DIGITAL SIGNATURE IN EMAIL BY USING OUTLOOKव ्USING OUTLOOK TO SEND DIGITALLY SIGNED 

EMAIL                                   

 

Digitally sign a single message 

In the message, on the Options tab, in the Permission group, click Sign Message. 

 If you don't see the Sign Message button, do the following: 

 In the message, click Options. 

 In the More Options group, click the dialog box launcher  in the lower-right corner. 

 Click Security Settings, and then select the Add digital signature to this message check box. 

 Click OK, and then click Close. 

 If you don't see the Sign Message button, you might not have a digital ID configured to digitally sign messages, and you need 
to do the following to install a digital signature. 

 On the File menu, click Options > Trust Center. 

 Under Microsoft Outlook Trust Center, click Trust Center Settings > Email Security 

 Click Import/Export to import a digital ID from a file on your computer, or click Get digital IDs to find a list of services that issue 
digital IDs for your use. 

Compose your message, and then send it. 

DIGITALLY SIGN ALL MESSAGES 

1. On the File tab, click Options >Trust Center. 
2. Under Microsoft Outlook Trust Center, click Trust Center Settings. 
3. On the Email Security tab, under Encrypted Mail, select the Add digital signature to outgoing messages check box. 
4. If available, you can select one of the following options: 
5. If you want recipients who don't have S/MIME security to be able to read the message, select the Send clear text signed message 

when sending signed messages check box. By default, this check box is selected. 
6. To verify that your digitally signed message was received unaltered by the intended recipients, select the Request S/MIME receipt 

for all S/MIME signed messages check box. You can request notification telling you who opened the message and when it was 
opened, When you send a message that uses an S/MIME return receipt request, this verification information is returned as a 
message sent to your Inbox. 

7. To change additional settings, such as choosing between multiple certificates to use, click Settings. 
8. Click OK on each open dialog box. 

-------------------------------नोट्स फनाने हेतु स्थान   

 

 

 

 

 

  



 

BALAJEE COMPUSOFT P LTD BHOPAL --------TOLL FREE  180030002448  Page 25 

 

 
 
 
 
 
 
 

SOURCES AND REFRENCES 
 
 

CCA website:  http://cca.gov.in 
 

NIC- CA website:  http://nicca.nic.in 
 

Interoperability Guidelines for Digital Signature Certificates: 

http://cca.gov.in/rw/pages/index.en.do 
 

IT ACT 2000  http://www.mit.gov.in/content/information-technology-act 
 

Wikipedia http://www.wikipedia.org 
 

Nemmadi   http://nemmadi.karnataka.gov.in/ 

 
गूगर –GOOGLE 

 

 
 

COMPILATIONS / टीभ एिॊ सहमोग – 
 

 SUNIL SINGH VERMA ( TECHNICAL INCHARGE BCSPL) BE.CS 

 SUPPORTING STAFF – AMLESH SINGH ( TECHNICAL ASSISTANT )BE.EC  

 DEEPENDRA – BCOM   KAJOL  ( BCOM PGDCA) फाराजी साल्मुशॊस / फाराजी कम्तमुसाफ्ट बोऩार  

 GWALIOR – तोभय JABALPUR – हरयशी ससॊह , इॊदौय – पे्रभ एयण 

TOLL FREE NUMBER FOR DIGITAL SIGNATURE HELP FOR FOREST DEPARTMENT 

 

TOLL FREE  180030002448  

 

 

LANDLINE 0755-4292405  | MOBILE - 9407532405 9407532411 

EMAIL – dsc@digitalsignature.net.in | Website www.digitalsignature.net.in/forestit 

CORRESPONDENCE – BALAJI SOLUTIONS(BCSPL) 116 SUNNY PLACE MP NAGAR 
ZONE 1 OPP DB MALL NEAR HOTEL SURENDRA VILAS BHOPAL MP PIN 462011  

 
 

-------------------------------------------------*******Thank you Very Much *********------------------------------------------------------------- 
 

  



Male Female Nationality

L  A  S  T  N  A  M   E 

Date of Birth Gender 

City

State

Pin code

MobilePAN of Applicant

APPLICANT INFORMATION
 F    I   R   S   T        N  A  M   E M   I   D   D   L  E        N   A  M   E Affix recent passport 

size photograph of 
the applicant duly  

signed across

APPLICATION FORM - SIGNATURE / ENCRYPTION CERTIFICATE 

FOR GOVERNMENT ORGANIZATION

PLEASE FILL IN BLOCK LETTERS ONLY. ALL FIELDS ARE MANDATORY 

Page 1 of 1 Version 2.9

Org Address

Email ID

More Instructions available at: http://www.e-mudhra.com/instruction.html 

1 Year  

Class 1 Class 2 Class 3 

Signature Encryption Combo 

CLASS:

TYPE:

VALIDITY:

2 Years

D  D M M Y  Y  Y Y

Organisation
Name

Department

DOCUMENT PROOF (attested by Authorized Signatory of the Organization)

                 eMudhra Limited, 3rd Floor, Sai Arcade, 56, Outer Ring Road, Deverabeesanahalli, Opp Intel, Bangalore 560 103. 
Karnataka. Phone : +91 80 6740 1400 Fax : +91 80 4227 5306. Email : info@e-Mudhra.com Website: www.e-Mudhra.com.

DECLARATION BY APPLICANT
I hereby agree that   I have read and understood the provisions of e-Mudhra Certification Practice Statement (CPS)
and the subscriber agreement and will abide by the same.    The information provided in this form is true & correct to 
the best of my knowledge.   I accept publishing my certificate information in e-Mudhra repository.   I am aware of risks
associated in case of Class 1 Certificate,when storing the private key on a device other than a FIPS 140-1/2 validated 
cryptographic module.

(As in ID proof | Blue Ink Only)

AUTHORIZATION

  

Date

Place Authorized Signatory (Sign and Seal)
    Signature of the applicant

RA Name, Code & Seal Signature of RADate

TO BE FILLED BY RA OFFICE ONLY
I declare that the applicant has provided correct information in this  application form . I have checked and verified the application form and supporting documents. I hereby
take full responsibility for any wrong verification made,  or wrong documents submitted for the application.

I hereby authorize this  application on behalf  of the  
organization.I hereby confirm the mobile number of 
 Applicant given above. In case of class 3, I confirm  
the Physical Verification of Applicant.

 Document required:

Copy of Applicant’s Goverment ID Card / Letter from Organization / Pay Slip

Authorized Signatory Organisational ID Card / Self-Attested Letter of Organizational Identity

Copy of PAN Card of Applicant, if PAN provided

Application ID: (S) (E) (For Office Use Only)
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नोट्स फनाने के सरए स्थान 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


